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Wstep

O czym jest ten artykut?

Tak, jak widzicie po samym nieco zawitym tytule, artykut dotyczy Windows Forms i ich tworzenia w Visual
Studio .NET. Przeznaczony jest dla poczatkujacych, jak i dla zaawansowanych programistéow. Zaktadam, ze
Czytelnicy posiadajgq podstawowa znajomos¢ Visual Studio .NET, to znaczy wiedzg, w jaki sposéb poruszac
sie po interfejsie programu oraz ze znajq podstawy C#. Mysle, ze kazdy z Was cos$ znajdzie dla siebie do
przeczytania, postaratem sie zawrzec rozne rady i ciekawostki w catym artykule.

Technika komputerowa idzie caty czas do przodu, ten, kto byt ekspertem komputerowym piec¢ lat temu, dzi$
moze okazac sie laikiem, ktory nie wie, co za pomocg tego diabelstwa mozna zrobi¢. Zmienit sie sprzet,
oprogramowanie, metody programowania, (co nas najbardziej interesuje), a takze zmienit sie stopien
ztozonosci aplikacji. Aplikacje czesto tworzg wieloosobowe zespoty, gdzie jest wazne, by nie tworzy¢ od
nowa gotowych juz komponentow. Istotna jest dokumentacja, istotne jest projektowanie, lecz w tym
artykule zajmiemy sie tylko tworzeniem pewnego rodzaju ,klockow”, z ktérych sktada sie aplikacje.

Mozna tatwo wyobrazi¢ sobie sytuacje, w ktérej jest programista (albo nawet caty zespdt), szef i klient.
Wiadomo, ze programista to z reguty len i chce oszczedzi¢ sobie pracy, wiadomo, ze szef to dran, ktory
oczekuje od programisty na efekty jego pracy, a od klienta na pieniadze, za$ klient to dusigrosz, ktéry chce
zapfaci¢ jak najmniej za oprogramowanie, ktére zaméwit. W zwigzku z tym, ze wiedza ta jest powszechna -
powstata idea szybkiego tworzenia oprogramowania - aby nie musie¢ wszystkiego pisa¢ od poczatku i
umozliwi¢ tatwiejsze wykorzystywanie gotowych elementdw. Szybkos$¢ pracy zwieksza jej efektywnos¢, wiec
programista ma mniej na gtowie dzieki automatyzacji tej pracy, szef nie musi poganiac¢ programisty, a klient
otrzymuje szybciej oprogramowanie, a wiec i taniej (jesli pomysle¢ o wynagrodzeniu za godzine pracy, ktére
szef musi doliczy¢ do ceny produktu). Wszyscy dzieki automatyzacji, wspomaganiu i przyspieszeniu pracy sg
szczesliwsi, a Wy, jesli Wasz Wydziat posiada licencje MSDNAA, macie dostep do oprogramowania, ktore
umozliwia wygodne tworzenie aplikacji — do Visual Studio .NET.

Jak postugiwac sie tym artykutem?

Czyli co zrobié, zeby sie nie narobic¢?

Czytajcie i pomozcie mi pisa¢ aplikacje (to znaczy piszcie jg sami i patrzcie, czy nie ma btedow). Nie
zamiescitem kompletnego kodu Zzrddtowego, zeby Was zacheci¢ do dotkniecia klawiatury, a nie tylko
Sciggniecia plikdw i przejrzenia ich zawartosci. Z autopsji wiem, ze to, co sie samemu zrobi - zapamietuje
sie najlepiej. Dodatkowo w caty artykut wplecione sg porady dla programistéow, ktére mam nadzieje, ze
utatwig Wam zycie. Zaczynamy!

Tutorial

Czyli samouczek

Przede wszystkim, zeby zacza¢ prace, nalezy uruchomié Visual Studio .NET. Wybieramy w menu File > New
> Blank Solution... i wpisujemy nazwe nowego rozwigzania (solution). Ja wybratem wiele mdéwigca nazwe
LazyProgrammer. Warto stworzy¢ sobie rozwigzanie, zamiast od razu pakowac sie w projekt, a to dlatego,
Zze bedzie mozna w przysztosci stworzy¢ sobie w ramach tego samego rozwigzania kolejne projekty. Taka
organizacja pracy pozwala by aplikacje i biblioteki oraz zasoby byty osobnymi projektami, ale jednoczesnie
umozliwia fatwiejsze uzytkowanie kazdego komponentu w innych projektach.
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Po utworzeniu nowego rozwigzania nalezy stworzy¢ nowy projekt. W Solution Explorerze mozna klikna¢
prawym przyciskiem na nazwe stworzonego rozwigzania i wybra¢c Add > New Project. Wybieramy jeden
sposréd dostepnych jezykdw programowania (w tym przyktadzie uzyjemy C#) oraz Windows Control
Library jako typ projektu. Jako nazwe nowego projektu wpisatem MyCustomControls. Tutaj komputer
troche pomieli twardym dyskiem (chyba ze nie jest to Wasze pierwsze uruchomienie Visual Studio .NET) i
wyswietli okienko o nazwie UserControll.cs [Design].

Poniewaz chcemy czego$ sie nauczy¢, a nie tylko wyklika¢ - skasujemy pliki, ktdre powstaty w rozwigzaniu.
Aby tego dokona¢, otwieramy Solution Explorer, gdzie bedziemy mogli zaznaczy¢ pliki, a nastepnie
wybraé, co chcemy z nimi zrobi¢ (Kasowac! Kasowac!).

Salution Explorer - MyCustomControls
== H 8B =
!a Solution "LazyProgrammer' [1 project]
= IE?-] MyCustamContrals

= @ References
-+ System
i o Spstern.Data

- <3 Spstem.Drawing
b+ Systern wWindows Forms
Lo s Systermn. <ML

----- B Agzemblylnfo.ca

..... IlzeiControll . cs

Rysunek 1 - Solution Explorer

Warto w tym momencie wspomnie¢ o tym, co zostato wygenerowane przez Visual Studio .NET do tej pory.
Otdz - stworzyliSmy rozwigzanie (solution), o nazwie LazyProgrammer, ktére zawiera jeden projekt (patrz
rys. 1). Projekt nazywa sie MyCustomControls. Projektow moze by¢ oczywiscie kilka w obrebie jednego
rozwigzania, ale pdki co zajmiemy sie tym jednym. W projekcie zawarte sq dwa pliki, AssemblyInfo.cs i
plik UserControll.cs. W pliku automatycznie wygenerowanym przez Visual Studio .NET - UserControll.cs
- znajduje sie definicja naszej wtasnej kontrolki. Jest ona nam zupetnie niepotrzebna, poniewaz chcemy
pisa¢ wszystko od podstaw. W pliku AssemblyInfo.cs znajduje sie opis naszej aplikacji, lub biblioteki (w
zaleznosci od tego, co bedziemy tworzy¢). W detale dotyczace tego pliku nie bede sie zagtebiat, to temat na
inny artykut. Mozemy spokojnie usuna¢ wspomniane pliki, bo nie bedq one nam potrzebne.

W sekcji References zapisane sg odwotania do innych komponentéw dostepnych w systemie. Z punktu
widzenia programisty odwotania te sq wyswietlane w Solution Explorerze jako przestrzenie nazw. Warto w
tej chwili juz dodac referencje do przestrzeni nazw System.Design. W Solution Explorerze klikamy na
References prawym przyciskiem myszy i wybieramy Add Reference..., po czym znajdujemy odpowiedni
plik z przestrzenig nazw, klikamy OK.
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Iﬁ.dd Reference

office F.0.3300.0 C:ANwWINDOWS \Microzoft MET.
FRegCode 1.0.5000.0 C:ANwWINDOW S \Microzoft MET. .
ztdole F.0.33000 C:\Program FilezhMicrozoft. ME. .
System. Configuration. Install. dll 1.0.5000.0 CWwINDOWS Microzoft. MET. .
Syztem Data.dl 1.0.5000.0 C:ANwWINDOWS \Microzoft MET.
S_I,Istem Data EIrau:IeEhent dll 1.0.5000.0 L: '\WINDDWS “Microzaoft NET...
5 1.0.5000.0 - ) LMET. .
System DlrectnryServices.dll 1.0.5000.0 B HWINDDWS “icrozoft MET... =
Syztem. dil 1.0.5000.0 C:AWINDOWS \Microzaft MET.
Sugtern. D rawing. Dezign. dll 1.0.50000 CAWAMD DWW S \Microzoft MET. .
Systern. D rawing.dll 1.0.5000.0 CWwINDDWS 'lechsnft NET...

Rysunek 2 - Dodawanie referencji do bibliotek z poziomu Visual Studio .NET

Pora stworzy¢ wiasng klase i troche o niej opowiedziec.
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Add Uzer Contral...
Add Inherited Contral...

1 Add Component...

Add Beference. .
Add \wWeb Reference...

Set az Startlp Project
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Save MyCuztomControls

&4 1 Add Solution to Source Control...
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Remoye
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Rysunek 3 - Dodawanie klasy do projektu z poziomu Solution Explorera
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Wtasng klase dodajemy do projektu w sposob przedstawiony na rys. 3 - prawym przyciskiem na projekcie,

wybieramy Add > Add Class...

i w okienku dialogowym wpisujemy nazwe klasy. Nazwijmy klase

TextPanel. Po zaakceptowaniu nazwy klasy Visual Studio znédw momencik pomieli dyskiem i wypluje na

ekran kod zrodtowy utworzonej klasy. Wszystkiego, co ten kod robi omawia¢ chyba nie musimy?

To, co nas interesuje w tej chwili, to dodanie jednej linijki. Zamieszczam screenshota, bo przypomniato mi

sie co$ ciekawego.

BHusing Bystem;
Lusing Svstem. Design; [%

Hhnamespace MNyCustomlontrols
L {
FA0 Asunmmary=

I LA A sunmary>

=] public class TextPanel
{
B public TextPanel()
{
YR
S TODO: Add c

it

FAF Bunmmary description for TextPanel.

onstructor logic here

Rysunek 4 - Outlining (przed zastosowaniem)
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Tak, jak widzicie - dopisatem jedna linijke. Niezty ze mnie programista, co? Dopiszcie sobie jeszcze ponizej,
tam gdzie kursor na obrazku:

using System.ComponentModel;
using System.wWindows.Forms;
using System.Drawing;

using System.Drawing.Drawing2D;

Powinno sie przydac. Chciatbym Wam co$ pokazac - mozliwo$¢ zwijania kodu (outlining). Po lewej stronie
kodu sag takie linie oraz kwadraty z minusami lub plusami. Po prostu kliknijcie na ktéoryms$ kwadracie i
sprawdzcie, co sie dzieje.

Husing | o
B namespace MyCustomControls
{
LR
public class TextPanel
{
public TextPanel (). ..

Rysunek 5 - Outlining (po zastosowaniu)

Tak, jak ogodlnie wiadomo, w C# nad klasg pracujemy tylko w jednym pliku. Klasa moze zajmowac tylko
jeden plik, nie rozdzielamy pracy tak jak w C++ na plik nagtdéwkowy i plik z implementacjg klasy. W C#
podziat na nagtdwek i implementacje nie istnieje. Outlining zwieksza przejrzystos¢ kodu podczas jego edycji
- jesli pracujecie nad wielkimi klasami - mozecie sobie ograniczy¢ widocznos¢ elementow, ktére Was nie
interesujq. Bardzo przydatne. Mozna zamkna¢ czes$¢ kodu pomiedzy znacznikami #region NazwaRegionu i
#endregion, powstanie w ten sposdéb mozliwos¢ zwiniecia w ten sposoéb oznaczonego tekstu.

Pora zajac¢ sie dziedziczeniem. Jesli piszemy klase, ktéra w zasadzie robi to samo, co potrafi inna klasa,
Jtylko ze moja robi to lepiej”, bardzo dobrze jest skorzysta¢ z cudu techniki, ktéry nazywa sie
dziedziczeniem. Pozwala ono na wykorzystanie istniejacych juz funkcji klasy, po ktorej dziedziczymy.
Poniewaz wymarzytem sobie, ze moja kontrolka bedzie potrafita robi¢ réozne cuda z tekstem (nikt Wam nie
broni co$ innego przetestowac), a zostanie to zamkniete w panel, zeby tadnie wygladato - dziedziczymy po
klasie System.Windows.Forms.Panel, w sposob taki, jak ponizej podany (nalezy zmieni¢ jedng linijke w
kodzie):

pubTic class TextPanel : System.windows.Forms.Panel

Dzieki temu nasza klasa TextPanel zawiera w sobie juz funkcjonalno$¢ klasy Panel z przestrzeni nazw
System.Windows.Forms. To jest pierwszy krok do lenistwa, ktére chcemy osiggna¢. OK, wszystko pieknie,
tylko ze w tej chwili ta klasa nie rozni sie od swojej klasy bazowej (czyli tej, po ktorej dziedziczy). Trzeba
pomysle¢, co klasa powinna robi¢. Powiedzmy, ze pozwoli uzytkownikowi na wybranie czcionki, jej wielkosci,
oraz kata, pod jakim bedzie pisany tekst zawarty w tworzonym przez nas panelu. Mysle, ze to jako przyktad
wystarczy. Zamieszcze kawatek kodu zrédtowego, ktdry powinien powiedzie¢ wszystko za siebie:

public class TextPanel : System.windows.Forms.Panel
{

/// <summary>

/// Text string to be displayed

/// </summary>

private System.String textString;
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/// <summary>
/// Rotation of the text (in degrees)

/// </summary>

private System.Single textRotation;

public TextPanel()

{
//
// TODO: Add constructor logic here
//

3

}

Przyjrzyjmy sie jeszcze konwencji nazewniczej. Jak wiadomo, klasy potrafiag same zabezpiecza¢ swoje dane i
metody, uznac je za prywatne i nie da¢ nikomu do nich dostepu. Takie witasciwosci klasy (czyli po prostu
dane) nazywane sg w notacji camelCasing. Czyli pierwsza litera mata, a kazda litera kolejnego stowa
bedacego czescig nazwy - duza. To jest konwencja notacyjna zalecana przez Microsoft do nazywania
wiasciwoséci (zmiennych) prywatnych w klasie. Inaczej bedg nazywane zmienne publiczne, w notacji
PascalCasing. Warto chyba tutaj wspomnie¢, ze w catym .NET Frameworku sg stosowane witasnie takie
konwencje nazewnicze. Dobrze jest trzymac sie tych zasad, by kod jednolicie i tadnie integrowat sie z
klasami bazowymi Frameworka. Ponadto przy stosowaniu notacji camelCasing i PascalCasing dla pdl
prywatnych i publicznych na pierwszy rzut oka mozna juz widzie¢ w kodzie, do jakiego rodzaju pola
odwotujemy sie. To chyba najlepszy argument na ich stosowanie.

W tym miejscu warto zatrzymac sie na dtuzej i wspomnie¢ wiecej o nazewnictwie. Dobrg praktyka jest
nazywanie zmiennych w sposdb znaczacy, to jest taki, zeby z samej nazwy zmiennej wiedzie¢ od razu, co
zmienna przechowuje. Unikajmy wiec nazw zmiennych takich, jak X2, Aa, abc, j23, poniewaz sama nazwa
zmiennej nie mdwi nic na temat danych, ktére przechowuje. Najlepiej stosowaé nazwy zmiennych takie jak
przykfadowo: sqglConnection (wida¢, ze to prywatna zmienna - potaczenie z serwerem SQL), albo
SelectFilesDialog (publiczna zmienna - okienko dialogowego do wyboru plikow).

Pora teraz na wyjasnienie, co oznacza ponizszy fragment kodu:
/// <summary>
/// Text string to be displayed

/// </summary>

private System.String textString;

Komentarz, ktéry widzicie powyzej, rézni sie od standardowego tym, ze zapisany jest za pomocga trzech
slashy. W ten sposéb zapisane komentarze beda pdzniej stuzyly do wygenerowania dokumentacji klas w
formacie XML. Tag <summary> stuzy do zawarcia w nim, przed opisywanym elementem, krotkiego opisu,
do czego ten element stuzy - na przyktad opisania, ze jest to fancuch znakdw, ktéry bedzie wyswietlany.
Istnieje jeszcze kilka innych tagow, ktére najlepiej poznaé przez wpisanie trzech slashy przed metoda,
zmienng lub klasa. Na przyktad przy wpisaniu takiego komentarza przed metoda w klasie - Visual
Studio.NET automatycznie wygeneruje tagi dla opisu (<summary>), parametréw (<parameters>) i wartosci
zwracanej przez metode (<returns>).

Mysle, ze dobrze wszystko jest opisywac ,dla przysztych pokolen” programistow, ktorzy bedag korzystac z
Waszej pracy w przysziosci, lub podczas pracy przy wieloosobowym projekcie. W tym tez jest czysty egoizm
- jesli samemu komentuje sie dobrze swéj kod - fatwo potapac sie w nim po przerwie w pracy nad nim.
Zdarza sie czesto tak, ze programista przeglada swoj kod, nad ktérym pracowat wczesniej i chce
dopracowac go, co$ dodaé, co$ zmieni¢ i traci czas na odpowiedzenie sobie na pytanie: ,O co mi tutaj
wilasciwie chodzito?”. Sam komentuje i nazywam zmienne po angielsku - ze wzgledu na wiekszg
przejrzystos¢ i jednolitos¢ kodu podczas jego czytania. Ponadto wiekszo$¢ dostepnego powszechnie kodu
jest opisywana w jezyku angielskim i spdjniej wyglada kod opisywany w jednym jezyku.
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Ok, skoro mamy witasciwosci prywatne naszego komponentu, ktdrych nie mozna zmieni¢ z zewnatrz...
Dlaczego wtasciwie sg prywatne? Jak w takim razie je mozna spoza klasy zmieni¢? A jest na to metoda -
wiasciwosci i akcesory, pozwalajgce ustawi¢ metody zapisu i odczytu zmiennej.

Do kazdej wtasciwosci klasy w C# (i w pozostatych jezykach obstugiwanych przez Visual Studio .NET) mozna
stworzy¢ tak zwane akcesory (get i set), ktore pozwalajg odpowiednio na odczyt i zapis do tej zmiennej.
Mozna sobie wyobrazi¢ nawet napisanie ,interfejsu”, ktéry pozwala na podanie liczby arabskiej (na przyktad
123), ktéra zapisze do odpowiedniego stringa warto$¢ rzymska ,CXXIII”, ktéry bedzie te wartosé
przechowywat. Mozna tez w drugq strone - pobrac jako liczbe arabskg wartos¢ stringa okreslonego przez
warto$¢ rzymska. Zastosowanie raczej niepotrzebne, ale chyba obrazuje jedna z mozliwosci wykorzystania
akcesordw. Innym przyktadem moze byc¢ uzycie akcesora set w obiekcie koszyka zakupow w taki sposob, by
od razu po zmianie ceny produktu zmieniat catkowita sume wartosci produktéw w koszyku. Warto
zainteresowac sie wtasciwosciami i akcesorami, szczegdlnie programistom, ktorzy po jednym dniu zmienili
swoj profil z C++ na C#, faktycznie nie zapoznajac sie z wieloma udogodnieniami, jakie daje C#. Ponizej
fragment kodu:

public System.Single TextRotation

{
get
{
return this.textRotation;
3
set
{
if(textRotation != value)
{
this.textRotation = value;
this.Invalidate(Q);
}
3
}

To, co dzieje sie w tym fragmencie kodu, w akcesorze przy metodzie set, to sprawdzenie, czy wartosc
podana (value) rézni sie od wartoséci aktualnie przechowywanej w zmiennej textString. Jesli wartosci
réznig sie od siebie - zapisywana jest nowa wartos¢ i kontrolka jest informowana o zmianie swojego stanu
za pomoca metody Invalidate(). Istotne jest wywotanie tej metody, zeby kontrolka automatycznie
,harysowata sie” od nowa. Przy okazji kolejna ztota mysl — warto wpisywac this przed odwotaniem sie do
zmiennej czy metody w klasie. A to dlaczego? Nie mamy z tego zysku w szybkosci dziatania programu, ale
mamy zysk podczas programowania. Po napisaniu this i kropki, IntelliSense w Visual Studio .NET bedzie
podpowiadat nam tylko to, co moze zosta¢ uzyte w kontekscie klasy - unikamy w ten sposdb pomytek i
literéwek.

Warto jeszcze zwroci¢ uwage na linijke:
public System.Single TextRotation

Dlaczego napisatem jg w taki spos6b? Dobra szkotg pisania klas (ktére majg by¢ pdzniej uzywane w
wiekszym projekcie) jest uzywanie petnej ,$ciezki” przestrzeni nazw, po ktérej dostajemy sie do klasy, aby
zredukowac szanse ztego odwotania sie. Mozna wyobrazi¢ sobie sytuacje, w ktérej mamy zadeklarowane
uzycie dwdch przestrzeni nazw, ktére majq zdefiniowang klase Single, kompilator w przypadku, gdyby nie
zostata podana petna Sciezka dostepu do klasy, nie miat by jasnosci, do ktérej z przestrzeni nazw sie
odwotaé. Dlatego trzeba mu pomdc.

A teraz dam Wam chwilke czasu na napisanie odpowiednich akcesorow dla pozostatych wtasciwosci naszej
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klasy, w sposdb podobny, jak przedstawitem...

Juz? Super. Wszystko jest przygotowane, teraz postaramy sie wyswietli¢ zawartos¢ kontrolki. W tym celu
postuzymy sie Class View, czyli podgladem klas. Class View to zaktadka w Visual Studio .NET, za pomocg
ktorego mozemy przegladac hierarchie przestrzeni nazw i klas, w postaci drzewa. Przejdzmy przez to drzewo
podobnie jak na ilustracji ponizej.

et - MpCustomContrals

Lo

E--{E&] kyCustomControls
= £} MyCustomCaontrols

=9 TextPanel

EI&I; Bazes and Interfaces

EI% Fanel
L——_I&I; Bazes and Interfaces
EIQI; ScrollableControl
L:_|O|; Bazes and Interfaces
Elalg Caontral

%&g Bazes and Interfaces

zg’ AccezsibilibyM atifuClie
.= Beginlmvoke(Systam.[
=@ Beginlnvoke|Syztem.[
=@ BringTaFrant(]

Rysunek 6 - Class View, hierarchia przestrzeni nazw i klas

I odnajdujemy metode OnPaint, ktdrg nastepnie przecigzamy - prawym przyciskiem na nazwie metody w
liscie, Add > Override. Visual Studio .NET powinien utworzy¢ kawatek kodu, ktéry znajdziecie ponizej.

protected override void OnPaint(PaintEventArgs e)

{
// TODO: Add TextPanel.oOnPaint implementation
base.onPaint (e);

}

Powyzszy kod wygenerowany zostat przez Visual Studio.NET. Nalezy tylko teraz dodac¢ sama implementacje
rysowania zawartosci komponentu. Oczywiscie przedtem nalezy wywota¢ metode OnPaint() klasy, po ktorej
dziedziczymy, zeby odpowiednio narysowat sie caty ,podktad” pod obiekt naszej klasy. To juz zatatwit za nas
edytor. Tylko klepac...

protected override void OnPaint(PaintEventArgs e)

{
base.onPaint (e);
e.Graphics.RotateTransform(this.textRotation);
System.Drawing.SolidBrush brush = new System.Drawing.SolidBrush(this.ForeColor);
e.Graphics.DrawSstring(this.textString, this.Font, brush,
new System.Drawing.RectangleF(0.0f, 0.0f, (float)this.width, (float)this.Height));
}

Nie bede zagtebia¢ sie w detale powyzszego kodu, bo nie jest to tematem tego artykutu. Kod rysuje
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zawarto$¢ naszej kontrolki. Wspomne tylko, ze this.ForeColor i this.Font sg dziedziczone z klasy
System.Windows.Forms.Panel i nie trzeba bylo ich definiowa¢ wczesniej. To tez utatwi ustawianie w
Designerze (edytorze formularzy) wiasciwosci naszego panelu, skupimy je w jednym miejscu. W tym
momencie juz mamy witasng kontrolke, gotowg do uzycia w Designerze.

To znaczy prawie gotowa... Trzeba jeszcze nowo dodane wiasciwosci klasy opisac¢ i przypisa¢ je do
odpowiedniej kategorii i oczywiscie pozwoli¢ Visual Studio .NET na wyswietlanie nowej kontrolki w Toolboxie.
Wszystko, co trzeba zrobi¢, aby to umozliwi¢, to dopisanie paru linijek w kodzie.

[ToolboxItem(true)]

public class TextPanel : System.Windows.Forms.Panel

Nad definicjg klasy nalezy umiesci¢ tylko jedna linijke, a kontrolka, ktdrg opisuje dana klasa bedzie dostepna
do dodania w Toolboxie. W nawiasie przy ToolboxItem podaje sie parametr true, pomimo ze Visual
Studio .NET automatycznie przyjmuje taki wiasnie parametr dla kazdej nowo stworzonej klasy. Jednak
dobrze jest jawnie okresli¢ to dla kazdej swojej kontrolki - lepiej co do pewnych spraw mie¢ pewnos$¢, niz
liczy¢ na to, ze juz wczesniej zostata ustawiona odpowiednia wtasciwosé. Jeszcze dwie mate rzeczy do
zmiany:

[category("Appearance"),

Description("Text to be displayed in a control™)]
public System.String TextString

i...

[Category("Appearance"),

Description("Rotation of text in degrees")]

pubTlic System.Single TextRotation

Te dwie ostatnie zmiany piszemy nad poprzednio zdefiniowanymi akcesorami. Ustawiajg one odpowiednio
kategorie (Category) oraz opis (Description) kontrolki, ktéry bedzie pojawiat sie w Designerze. Dzieki
temu do wiasciwosci kontrolki bedziemy mieli dostep tak, jak ponizej na przyktadzie.

B Appearance
B ackColar [] Light5teelBlue
Backgroundimage [ ] [none]
BorderStyle Fizxed3D
Cursor Drefault
B Fart Time: Hew Roman;
M arme Times New Ron
Size 24
It Point
Bold True
GdiChars et 238
GdierticalFont Falze
I talic False
Strikeout False
Irderline Falze
ForeColar [ ] Gold
RightToLeft Mo
TextRotation 30
TextString Hello, World!

Rysunek 7 - Designer Class w dziataniu - nowe witasciwosci: TextRotation i TextString

Tak, jak wida¢ na zatgczonym obrazku - TextRotation i TextString pojawity sie w cze$ci Appearance we
wilasciwosciach naszej kontrolki. Wiele spos$rdéd innych wiasciwosci zostato odziedziczone po kontrolce
System.Windows.Forms.Panel, na przyktad kolor tta, styl obramowania, czcionka uzyta do pisania, kolor
napisu, i inne. Dziedziczenie oszczedza bardzo wiele pracy. A sama kontrolka po wyswietleniu bedzie
wygladata tak, jak ponizej.
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Rysunek 8 - Stworzona przez nas kontrolka na formularzu

Nie omowie w tym artykule we wszystkich atrybutéow oraz ich zastosowania, poniewaz jest to temat na
catkiem odrebny artykut. O wszystkim na ten (i nie tylko) temat mozna dowiedzie¢ sie uzywajac MSDN
Library.

Jeszcze jedna rzecz. Jak uzywac tej kontrolki z poziomu innego projektu? Wystarczy doda¢ do niej
referencje. Na przyktad: nalezy stworzy¢ nowy projekt C# Windows Application, o nazwie na przykfad
TesterApplication. Pozniej nalezy doda¢ w tym projekcie referencje do stworzonej biblioteki kontrolek.
Jesli znajduje sie ona w zakresie tego samego rozwigzania znajdziemy tatwo odpowiednie biblioteki w
zaktadce Projects okienka dodawania referencji. Ostatnim krokiem jest dodanie kontrolki do Toolboxa w
Designerze. Najlepiej chyba jest stworzy¢ sobie wtasng zaktadke - w projekcie TesterApplication
wchodzimy w Toolbox, dodajemy nowa zaktadke - prawym przyciskiem myszy na obszarze Toolboxa,
wybieramy Add Tab, wpisujemy nazwe, na przykiad My User Controls. Wybieramy nowo utworzong
zaktadke i wybieramy prawym przyciskiem myszy Add/Remove Items..., nastepnie w okienku Customize
Toolbox wybieramy Browse... i nawigujemy do katalogu, w ktérym jest nasza biblioteka, juz
skompilowana, czyli po prostu odpowiedni plik DLL. Wybieramy ten plik i nastepnie mozemy wybrac
odpowiednig kontrolke, ktdérg ta biblioteka zawiera, czyli TextPanel. Odpowiedni przycisk pojawi sie w
Toolboxie, przyczyniajac sie do wzrostu naszego prywatnego wspdtczynnika lenistwa. Od tej pory jest juz
gotowy do zastosowania tak jak inne przyciski, ktore Visual Studio .NET ma juz skonfigurowane:

Toolbox

Rysunek 9 - Toolbox zawierajacy przycisk ze zdefiniowana przez nas klasa

Podsumowanie

Czyli o przydatnosci artykutu
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Tak, jak widzicie, zycie programisty jednak lekkie nie jest. Niby jest leniwy, ale i tak musi sie do tego
lenistwa porzadnie przygotowac. Praca przy przygotowaniu sobie $rodowiska edycyjnego bardzo sie optaca.
Raz stworzong kontrolke mozemy wielokrotnie tatwo uzywa¢ w innych projektach, zbudowac¢ wiasng
imponujacq biblioteke komponentdéw i tak dalej. Przyktad, tu zamieszczony celowo nie byt zbyt przydatny, by
sktoni¢ Was do przemyslenia zastosowania i wtasnej pracy. Po co komu obracany tekst? Jest catkowicie
nieprzydatny :). Inne pomysty na wtasng kontrolke to na przyktad kontrolka, w ktorej podaje sie réwnanie
oraz zakresy wspotrzednych X i Y, a kontrolka juz bedzie sama sobie rysowata wykres. Ciekawa by tez byta
wizualizacja danych pobieranych przez kontrolke z jakiego$ Zzrddta. Mozliwosci jest sporo, jedynym
ograniczeniem, jakie przed Wami stoi, jest Wasza wyobraznia, czyli ograniczen po prostu nie ma.

Mam nadzieje, ze artykut Wam sie przydat. Do zobaczenia, a wtasciwie — do przeczytania!

-Marcin ‘Vigrid” Seredynski

Drukuj Zamknij
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